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] Cnyx6a DHCP

The Dynamic Host Configuration Protocol
BUKOPUCTOBYETbLCH ans CNPOLLEeHHSA

KOH(pirypyBaHHa [P-knieHTIB ¥ Mepexi TCP/IP
LLMIAXOM IX aBTOMaTUYHOIO HanaluTyBaHHA.

[lepeBarn BUKOPUCTAHHA NMPOTOKONY:

B [JO3BONSIE YHUKHYTU PY4YHOro HanaluTyBaHHS
KOMM'IOTEPIB MEPEXI;

B 3MEHLUNTU KINbKICTb NOMWUIIOK npu
HanaluTyBaHHI.



] Cnyx6a DHCP

[1lpouec oTpmmaHHa IP-agpecu:

1. BuasneHnsa DHCP (Discover)

2. 3anpoweHHa DHCP (Offer)

3. 3anut DHCP (Request)

4. NigTBepmxeHHss DHCP (Acknowledge)
[1lpouec oHoBNeHHA IP-agpecu:

1. 3anut DHCP (Request)

2. [TligTBepoxeHHa DHCP (Acknowledge)



[ HNonaBaHHA poni DHCP

i3 Da:
# Lo
s Al
i§ AD
& DN

L FilJ

Select server roles

Before You Begin

Installation Type

Server Selection

Features

Select one or more roles to install on the selected server.

ctive Directory Certificate Services

v Active Directory Domain Services (Installed)
[] Active Directory Federation Services

[] Active Directory Lightweight Directory Services
[] Active Directory Rights Management Services
vy - s . n

R
[] Fax Server
¢ [m] File and Storage Services (2 of 12 installed)
[[] Host Guardian Service

[] Hyper-v

[] MultiPoint Services

[] Network Controller

[] Network Policy and Access Services

[] Print and Document Services

[[] Remote Access

[] Remote Desktop Services

[] Volume Activation Services

[[] Web Server (1IS)

DESTINATION SERVER
DC-1.landonhotellocal

Description

Active Directory Certificate Services
(AD CS) is used to create
certification authorities and related
role services that allow you to issue
and manage certificates used in a
variety of applications.

< Previous

Next >

Install Cancel

Services ’ \ Services

Services
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u HNonaBaHHA poni DHCP
DESTINATION SERVER

Installation progress C-tandonhotelloca!

View installation progress

o Feature installation
e
Configuration required. Installation succeeded on DC-1.Jandonhotel.local.

H p DO -in " W| £

¢ h ;
Complete DHCP configuration :

Remote Server Administration Tédls
Role Administration Tools
DHCP Server Tools

You can close this wizard without interrupting running tasks. View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

| < Previous Next > Close Cancel




] NopaBaHHA poni DHCP

fis DHCP Post-Install configuration wizard

Description

Authorization

The following steps will be performed to complete the configuration of the DHCP Server on the
target computer:

Create the following security groups for delegation of DHCP Server Administration.

- DHCP Administrators
- DHCP Users s

Authorize DHCP server on target computer (if domain joined).




] HanawTyBaHHsA poni DHCP

¥ DHCP
File Action View Help

s | m = HM L

% DHCP Contents of DHCP Status

v & dec-llandonhotel.local 3 dc-1.landonhotel.local
v B IPv4

.3 Server Options
J| Policies k
> ¥ Filters
> @ IPvE




] HNonaBaHHA obnacti DHCP

% DHCP Contents of DHCP !
v 3 dec-llandonhotel.local B de-1andonhotellocal
v i. 1Dvi4
Display Statistics...
>
> @
7 ; New Scope Wizard
Configure Failover..,
Replicate Failover Scopes... IP Address Range
Define User Classes... You define the scope address range by identifying a set of consecutive |P addresses.
Define Vendor Classes...
Reconcile All Scopes... ~ Configuration settings for DHCP Server
Set Predefined Options... Enter the range of addresses that the scope distributes.
Refresh Start IP address: I 10. 3 .66 . 221
Properti
it End IPaddress: | 10 . 3 . 66 .230
Help
I

i~ Configuration settings that propagate to DHCP Client

Length: [ 2]

Subnet mask: |255‘255.255. 0

<B§ck} Next > Cancel




] HNonaBaHHA obnacti DHCP

New Scope Wizard

Add Exclusions and Delay
Exclusions are addresses or a range of addresses that are not distnbuted by the
New Scope Wizard server. A delay is the time duration by which the server will delay the transmission of a
DHCPOFFER message.

Add Exclusions and d
r——, ”Dda'“a of add that are not distrbuted TypethelPaddesslmge_thayouwattoaucbde.Iyouwaﬂoewbdeau#e
server, A delay is the time duration by which the server will delay the tran address, type an address in Start IP address only.

DHCPOFFER message. Start IP address: End IP address:
Type the IP address range that you want to exclude. I you want to exclu I | . ) ) I
address, type an address in Start |P address only.
Start IP address: End IP address: Excluded address range:
|1o‘3.ss.225|1oA3.ss.22q Md[l Remove
Excluded address range: %
Subnet delay in milli second:
| n a '
< | ? DHCP Contents of Scope
Subnet delay in mil v 3 dec-llandonhotel.local 1§ Address Pool
0= v P [ Address Leases
v 2 Seans 1102 A6 M | andanHatelClients e ¥
Display Statistics... :J TAR@tions
|_4Scope Options
Advanced... > 1] Policies
Configure Failover... Cancel ‘
<Back | ' Reconcile...
>
> i View >
Delete
Refresh
Export List...
Properties
9
Help




] HanawTtyBaHHA BnactuBocten DHC

‘$ DHCP
File Action View Help
e | 2@ c|HEm &
% DHCP
v i de-1.landonhotel.local @ Scope Opti
v 3 IPv4
=] Sc 10.3.66.0] LandonHotelClients
v "of\:k[i P : s Scope options are additional configuration parameters that a DHCP server can assign to DHCP clients, For example, some commonly
‘-? 55100 used options include IP addresses for default gateways (routers), WINS servers, and DNS servers,
| ¢ Address Leases
> =] Reservations Scope options override server options.
., Scope Options ) ) )
& Policies [:} To set the scope options, on the Action menu, click Configure Options.
3 Server Options For more information about scope options, see online Help.
2| Policies
> ¥ Filters
> B IPv6
@ DpHCP

i ocbon: Yeew” Ealp
e | nm ol @ &

% DHCP
v 3 de-llandonhotel.local @ Scape Ottas
v i 1Pv4
=1 Se 10.3.66.0] LandonHotelClients 2 2 3 ; ; 3
va oz:([’ P } e Scope options are additional configuration parameters that a DHCP server can assign to DHCP clients, For example, some commonly
%g Add'ess L°° used options include IP addresses for default gateways (routers), WINS servers, and DNS servers,
C ress Leases
) Reservations Scope options override server options.
_:"‘; SCOPQ Ontion
& Policie To set the scope options, on the Action menu, click Configure Options.
(A Server Op - For more information about scope options, see online Help.
) Policies Vion 2 s R
> ¥ Filters Refresh
> B IPv6
Help
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] HanawTtyBaHHA BnactuBocrten D

Scope Options ? X
General Advanced
Available Options | Description A
[¥] 003 Router Amray of rout
[ 004 Time Server Amray of time
[J 005 Name Servers Amray of nan
[¥] 006 DNS Servers Amay of DN v
< >
 Data entry
Server name:
IP address:

OK

Scope Options ? >
General  Advanced
fwailable Opt ]E —
L1014 Merit Dump File Path name f
(v 015 DNS Domain Mame DNS Domai
L1 016 Swap Server Address of ¢
1017 Rt Path Path name f v
< 3
~ Diata entry
String value:
landonhatel locall
Aoply

11




] HanawTyBaHHA Kni€H

Internet Protoceol Version 4 (TCP/IPv4) Properties Ethernet adapter Ethernet:

Connection-specific DNS Suffix
Description

Physical Address.

DHCP Enabled. N m
Autoconfiguration Enabled
Link-local IPv6 Address
IPv4 Address.

Subnet Mask

Lease Obtained.

Lease Expires

Default Gateway

DHCP Server

DHCPv6 IAID . .
DHCPv6 Client DUID.

DNS Servers

General Alternate Configuration

You can get IP settings assigned automatically if your netwg
this capability. Otherwise, you need to ask your network ad
for the appropriate IP settings.

_§] Obtain an IP address automatically

() Use the following IP address:

-

NetBIOS over Tcpip.

®) Obtain DNS server address automatically

e

() Use the following DNS server addresses:

Mo

Media State

| . Connection-specific DNS Suffix

| File Action View Help
| nm G

@ DHCP
v 3 dec-llandonhotel.local

ale SETONOS upon et Advi
v _:D IPv4

OK

¢ Address Pool

& Address Leases
@/ Reservations
, Scope Options

2| Policies

.4 Server Options

2| Policies

¥ Filters

'3 IPv6

1% 10.3.66.221

|| 1%510.3.66.222
v || Scope [10.3.66.0] LandonHotelClie:

landonhotel.local
Microsoft Hyper-V Network Adapter

00-15-5D-42-64-24

: Yes
: Yes

fe80::380d:476f:7c28:8fcb¥%4(Preferred)
10.3.66.222(Preferred)

255.,255,.255.0

Wednesday, October 19, 2016 11:23:22 AM
Thursday, October 27, 2016 11:23:20 AM
16.3.66.1

16.3.66.201

33559901 R

00-01-00-01-1F-98-63-AC-00-15-5D-42-64-2¢

18.3.66.201
18.3.66.202
Enabled

Tunnel adapter isatap.landonhotel.local:

Media disconnected
landonhotel.local

) AD

Client IP Address Name

car-booth-05-pc
Client-1.landonhot...

12



u Ba3za gaHnx DHCP

% DHCP
2 once v F de-1Jandonhotellocal
File Action View Help w i. IBued

o9 nmXE G| HmQO: Display Statistics..

¥
¥ DHCP New Scope...
v 3 dc-1landonhotel.local
! Add/Remove Bindings... dc-1.landonhotel.local Properties ? X
> ®  Unauthori
nauthorize
View 4 I ELER M C \Windows\system 32\dhep

N

Backup path: lC:\Wndows\system&Z‘d\cp\bado.p

'

&« v A > ThisPC » Local Disk(C:) > Windows > System32 > dhcp >
Name Date modified Type Size
3 Quick access
backup 10/18/2016 1:11 PM  File folder
Il Desktop » = ) ) )
| ] dhep.jfm 10/19/2016 10:06...  JFM File 16 K8
¥ Downloads ~ # [ dhep.mdb 10/19/201610:11...  MDB File 1,024 KB
Documents  # [ gheppat 10/19/2016 1:11 PM  PAT File 0KB
[&=] Pictures #  |5] DhepSrvlog-Wed 10/19/2016 10:06...  Text Document 3K8
- 2
B This PC DhcpV6SrvLog-Wed 10/19/201610:06...  Text Document 2KB
e j50.chk 10/19/2016 10:06...  Recovered File Fra... 8K8
W Desktop = jso 10/19/20161:11PM  Text Document 1,024 K8
[} Documents [ j50res00001 jrs 10/19/2016 10:01...  JRS File 1,024 KB
& Downloads [] j50res00002,jrs 10/19/2016 10:01...  JRSFile 1,024 K8
D Music | j50tmp 10/18/2016 1:11 PM  Text Document 1,024 KB



L OcHoBu 6e3nekun DHCP

¥ oHCp

File Action View Help

G EEEN =

& DHCP Contents of DHCP Server Status Description Faile
v 3 dec-llandonhotel.local I Server Options
i i g&mr Options ] Scope [10.3.66.0] LandonHotelClients ** Active **
5 [ Scope [10.3.66.0] LandonHotelClie % PF‘::'S“ s - r X
< = 1
B Policies General DNS  Fiters Falover Advanced
s @ Filters

> @ IPvE *S

™ Automatically update statistics every:
Hours: Minutes:
P | -
s s

v Enable DHCP aud? logaina
Writes server activity to a file dady to monitor system performance and

Show the BOOTP table folder

Displays the server table which can contain configuration entries to
support BOOTP chents.

14



L OcHoBu 6e3nekun DHCP

oo 2mEc=HE P

% DHCP
v 3 dec-llandonhotel.local
v i 1Pv4
'3 Server Options
v || Scope[10.3.66.0) LandonHotelClie
'§} Address Pool
& Address Leases
> (5 Reservations
[, Scope Options
(] Policies
] Policies
> ¥ Filters
> B IPvé

Contents of DHCP Server

{3 Server Options

= Scope [10.3.66.0] LandonHotelClie
1 Policies

I Filters

o

Status Description

** Active **

IPv4 Properties ? X

General DNS  Fiters Failover Advanced

You can setup the DHCP server to automatically update authortative DNS
servers with the host (A) and pointer (PTR) records of DHCP clients.

[V Enable DNS dynamic updates according to the settings below:
¢ Dynamically update DNS records only if requested by the DHCP

" Mways dynamically update DNS records
[V Discard A and PTR records when lease is deleted [;

I~ Dynamically update DNS records for DHCP clients that do not request
updates {for example, clients running Windows NT 4.0)

™ Disable dynamic updates for DNS PTR records

Name Protection
DHCP name protection is disabled at the server level.

15



[ TunoBi npo6nemu Hana

m KoHNIKT IP agpec

OoHa IP  apgpeca nMpPOMNOHYETLCA AOEKINTbKOM
KNnieHTam

m KnieHT He oTpumye IP agpecy Big DHCP

KnieHTy Npu3Ha4vYaeTbCH APIPA agpeca
(Automatic Private IP Addressing) 3 giana3oHy

Big 169.254.1.0 0o 169.254.254.255

m KnieHT otpumye IP agpecy 3 HeBIpPHOro
Oiana3oHy agpec

m [lomunka 34utyBaHHa ©0a3m pgaHux DHCP
cepBepa

16



] HanawTtyBaHHsa DHCP failover

Configure Failover

Create a new failover relationship

¥ DHCP
v [ dc-2landonhotellocal
“ [Pwd
L5 Server Options
4 Policies Create a new failover relationship with partner dc-2
s @) Filters [y
> i IPvE
Relationship Name:
Madmum Client Lead Time: I ilb hours 0 -] minutes
=l =l
Mode | Load balance ~|
Load Balance Percentage
Local Server: I 1%
Eu;l
es2mfcE BmDE syttt 50-+*
‘2 %HCP Conte
v dc-1.landonhotel.local - -
- { g =1 minutes
v _3 f:l [ State Switchover Interval: 60—
> B Display Statistics... o ¥ Enable A
H' New Scope... il
5 § New Superscope... Shared Secret: |
> B! New Multicast Scope...

« Back Next > Cancel
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] HanawTtyBaHHsa DHCP failover

Scope 10.3.66.0 Statistics u Configure Failover

Description | Detaiis | Create a new failover relationship

Total Addresses 8

In Use 2 (25%)

Available 6 (75%)

Addresses Available {this Server's Pool) 3 (37%)

Addresses Available (Partner Pool) 3(37%) e >
Addresses granted this Server's Pool)  1(12%) RS e S AR WS pR B2
Addresses granted (Partner Pool) 1(1 2‘/%

Refresh || Cose |

‘@ DHCP
| File Action View Help

e 2m G=|Hm *
& oHce

v 3 de-2landonhotel local
v B IPv4
v | Scope [10.3.66.0] LandonHotelClients

i} Address Pool

Relationship Name: |dc-1 landonhotel local-dc-2
Madmum Client Lead Time: | 15“»0\:3 I o_%niues
Mode: h Hot standby
~ Hot Standby Configuration —
Role of Partner Server: | Standby ~|

< Back Ned> | | Cancel
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"
[1nsa BUKOHaAHHS NnabopaTopHOI podboTH
3HaOoOUTbLCS:

1. CepBep Windows Server 2016 BuaineHun
ana niasmweHHa go poni DHCP.

2. KnieHTt, wo byge oTtpumyBaTn KoHdUrypawito
IP.

3. JlogaTkoBuU cepBep DHCP ans
3abesneyeHHs BiOMOBOCTIUKOCTI.

19



] Pe3lome

Pe3tome (Lo BCTUIMN 3a JeKLito)

m PoarnaHynu gesaki ocoonuesocti Windows
Server 2016 DHCP.

m Po3rnaHynu npoueaypy HanawTyBaHHS
Windows Server 2016 DHCP.

m Po3rnaHynu geski ooaaTtkoBl MOXITUBOCTI.
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